
 
 

 

The Write Stuff         Autumn 2021          Vol. 18 No. 4 

 

Published by the scientific editors and librarians in the Research Medical Library,  

The University of Texas MD Anderson Cancer Center 

 

 

 

In this issue... 

– The growing acceptance of preprints in biomedical publishing 

– NIH biosketch changes 

– Opening up the functionality of Microsoft Word with the Read Aloud tool 

– NCI’s AuthorArranger tool for manuscript title pages 

– NIH tips for writing a research plan 

– Unusual terms used in scientific writing and publishing: Creative Commons 

 

 

 

The growing acceptance of preprints in biomedical publishing 

 

– Bryan Tutt 

 

Preprint servers, also called prepress servers, are widely used in many academic 

disciplines to publish and receive feedback on research articles before peer review and 

publication in an academic journal (1). Articles posted on such servers are called 

preprints. 

 

Biomedical research was slower than other fields to adopt the use of preprints. Although 

the publication of preprints gradually increased in biomedical research in recent years, 

many researchers remained reluctant to release unrefereed (i.e., non–peer reviewed) 

findings as preprints (2). The emergence of COVID-19 changed this dynamic in the first 

months of 2020. 



“[A]longside the public health crisis, the COVID-19 pandemic also triggered a scientific 

emergency,” wrote Vasconcelos et al. (3), who modeled the increase in COVID-19–related 

preprints over time. “The scientific community has met this challenge by producing an 

unprecedented number of scholarly works in a very short period of time.” Between 

January 1, 2020, and October 31, 2020, more than 125,000 manuscripts on COVID-19 

were published, and more than 30,000 (about 25%) of these were preprints (4,5). 

 

Another effect of the pandemic on the use of preprints was noted by Fraser et al. (4), 

who found that 85% of the corresponding authors who posted a preprint about COVID-

19 from January through October 2020 had never before posted a preprint. These 

researchers focused on two of the larger biomedical preprint servers, bioRxiv and 

medRxiv (Rxiv is pronounced “archive”), and found that 10,232 COVID-19 preprints were 

posted on these servers during this time. By comparison, 78 Zika-related and 10 Ebola-

related preprints were posted on the two servers during the entirety of those pandemics 

(2015-2016 and 2014-2016, respectively). 

 

Despite the growing acceptance of preprints, many clinicians and researchers have valid 

concerns about the spread of misinformation on preprint servers (6). Bero et al. (7) 

analyzed 67 COVID-19 studies that were reported first as preprints and later as peer-

reviewed journal articles. At least one discrepancy between the two versions was found 

in the results of 23 (34%) of the studies: 8 studies had results published in the preprint 

but not in the journal article, and 15 had results published in the journal article but not 

in the preprint. However, the peer review process is also imperfect. Science journalist 

Leonid Schneider (8) noted that although preprints have been used to spread fraudulent 

COVID-19 papers (e.g., presenting anti-vaccine propaganda or promoting unproven 

treatments), such papers have also been published in peer-reviewed journals. “[T]he 

biggest damage during this COVID-19 pandemic came from peer-reviewed papers 

published in respectable journals by respectable publishers,” Schneider wrote. “Most of 

those are never retracted, while many problematic preprints have been pulled.” 

 

Most preprint servers have screening checks in place to ensure some level of quality in 

their articles. A study of 44 preprint platforms found that 75% screened articles to rule 

out unscientific content, plagiarism, and/or unverified claims (9). Furthermore, many 

medical preprint servers include a disclaimer in each article that the content is not peer 

reviewed and should not be used to guide clinical decisions. 

 

Although peer-reviewed articles remain the gold standard in biomedical publishing, 

preprints have established themselves as a useful medium. For many researchers, the 

benefit of making their findings available quickly as a preprint outweighs the risk of 

publishing an error that can be corrected later in peer review. 

https://www.biorxiv.org/
https://www.medrxiv.org/
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NIH biosketch changes 

 

– Sunita Patterson 

 

The biographical sketches, or biosketches, for the principal investigator and other 

senior/key personnel are an important part of NIH grant applications. Some minor but 

important changes to their format are being phased in. The NIH has been encouraging 

researchers to use the new format, which became effective on May 25, 2021, and its use 

will be mandatory beginning January 25, 2022. 

 

Notice NOD-OD-21-073 details the changes: 

• Section B, formerly “Positions and Honors,” has been renamed “Positions, 

Scientific Appointments, and Honors” and now requires disclosure of all research 

positions, not just those relevant to the application. The instructions explicitly 

include non–U.S. appointments and unpaid appointments: “List in reverse 

chronological order all positions and scientific appointments both domestic and 

foreign, including affiliations with foreign entities or governments. This includes 

titled academic, professional, or institutional appointments whether or not 

remuneration is received, and whether full-time, part-time, or voluntary (including 

adjunct, visiting, or honorary).” Note that the order should now be reverse 

chronological (most recent position first) rather than chronological. 

• A list of ongoing and completed research projects/support no longer appears in 

Section D of the biosketch. In non-fellowship biosketches, Section D has been 

removed. In fellowship biosketches, Section D now covers Scholastic Performance 

only. 

• If you want to bring to the reviewers’ attention any ongoing or completed 

research projects from the past 3 years that you would have previously listed in 

Section D, you can mention them in Section A, Personal Statement. 

 

For the new biosketch forms, instructions, and examples, see the NIH biosketch web 

page. The NIH has a new email address for inquiries related to biosketches: 

nihosbiosketch@nih.gov. In addition, MD Anderson’s Office of Sponsored Programs can 

answer questions about biosketch formatting and structure: 

ospconcierge@mdanderson.org. 

 

 

 

 

 

https://grants.nih.gov/grants/guide/notice-files/NOT-OD-21-073.html
https://grants.nih.gov/grants/forms/biosketch.htm
https://grants.nih.gov/grants/forms/biosketch.htm
mailto:nihosbiosketch@nih.gov
mailto:ospconcierge@mdanderson.org


Opening up the functionality of Microsoft Word with the Read Aloud tool 

 

– Don Norwood 

 

If you’re looking to go beyond the usual reading, writing, and editing uses of Microsoft Word, 

the Read Aloud function is a good place to start. Like the name says, with this tool, a voice 

generated by the program reads the text in a document out loud. 
 

Apart from the obvious benefit of making Word documents accessible to people whose vision is 

impaired, Read Aloud has a few handy uses. For example, it can be used to proofread a 

document. Following along with the text while the voice reads it is a handy way to make sure it 

says what you want it to. Also, it can help you better understand the content of a document, 

especially if you’re an auditory learner. Hearing a passage of text read out loud adds a new 

dimension of understanding beyond that with just reading it yourself. Third, it’s perfect for 

multitaskers. You can listen to a document being read while doing something else. 
 

Using Read Aloud is quite simple. 

• Place the cursor where you want the reading to start. 

• Go to the Review tab at the top of the Word window and click “Read Aloud.” If “Read 

Aloud” is not on that tab, go to the “View” tab and click “Immersive Reader” followed by 

“Read Aloud.” 

• In the box that opens up, click the “Play” button. That button then changes to a “Pause” 

button. 

• Click the “Previous” and “Next” buttons to go to other paragraphs. 

• Click the “Stop” button to end Read Aloud. 

 

One thing to remember is that the cursor moves through the text when Read Aloud is playing. If 

you alter the text while this is happening, you may accidentally delete some of the text. 

Therefore, stop and exit Read Aloud before making any changes. 
 

You can also change the settings for Read Aloud. This is done by clicking on the far right button 

in the box that opens when you click Read Aloud. There you can change the reading speed as 

well as the voice. In addition, to change the language in Read Aloud, go to the “Review” tab and 

click “Language.” There you can select from a long list of languages. Just remember that the 

language you select will be used as the proofing language for the document. If you want to use 

English as the language when you check the spelling and grammar, you will have to repeat this 

process and select English. 
 

Regarding the use of Track Changes in Microsoft Word, Read Aloud will read all of the text that 

appears in the document. If the All Markup feature is on in Tracking, it will read everything as it 

appears, which could be quite confusing. Therefore, either switch to No Markup or Original in 

Tracking or use a version of the document without tracked changes with Read Aloud. 
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NCI’s AuthorArranger tool for manuscript title pages 

 

– Stephanie Deming 

 

If you prepare manuscripts for submission to journals, consider incorporating the NCI’s 

AuthorArranger tool into your standard workflow. AuthorArranger allows users to 

automatically format author names and author affiliations for the title page of a 

manuscript. 

 

To use AuthorArranger, first you create a spreadsheet with author details. You can use 

the fillable template spreadsheet supplied by AuthorArranger or create your own 

spreadsheet file. Next, you upload the spreadsheet to AuthorArranger. Then you use the 

straightforward AuthorArranger web tool (Figure) to control how author names and 

author affiliations appear. As you click and slide buttons on the left side of the screen, a 

preview of the author details automatically updates on the right side. 

 

 
 

Once the text in the Preview pane appears as you wish, you can copy the text and paste 

it into your manuscript, or you can download the text as a Microsoft Word document. 

https://www.minitool.com/news/make-microsoft-word-read-aloud.html
https://www.minitool.com/news/make-microsoft-word-read-aloud.html
https://support.microsoft.com/en-us/office/listen-to-your-word-documents-5a2de7f3-1ef4-4795-b24e-64fc2731b001#ID0EBD=Windows
https://support.microsoft.com/en-us/office/listen-to-your-word-documents-5a2de7f3-1ef4-4795-b24e-64fc2731b001#ID0EBD=Windows
https://authorarranger.nci.nih.gov/#/
https://authorarranger.nci.nih.gov/assets/files/AuthorArranger%20Template.xlsx
https://authorarranger.nci.nih.gov/#/web-tool


If multiple authors have the same affiliation, AuthorArranger will recognize this and 

show the affiliation only once, which is the approach preferred by most journals, rather 

than repeating the affiliation for each author. 

 

AuthorArranger includes a helpful brief User Guide that explains how to upload author 

information, format author names and affiliations, change the order in which authors are 

listed, and remove authors (or restore authors if they are removed by mistake). The User 

Guide also explains that any uploaded information is automatically deleted from the 

AuthorArranger web server when the user’s web browser is closed. 

 

Consider creating an author-details spreadsheet each time you begin work on a 

manuscript. When it comes time to create the manuscript’s title page, you will be able to 

quickly format the author details using your spreadsheet in combination with 

AuthorArranger. For greatest efficiency, you can maintain a central spreadsheet with 

details for all of the authors with whom you regularly publish manuscripts. Then, to 

make the AuthorArranger spreadsheet for a new manuscript, you can make a copy of 

your central spreadsheet, delete any individuals who are not authors of the new 

manuscript, and add authors as needed. 

 

If you use AuthorArranger, the NCI asks that you acknowledge use of the tool in the 

Acknowledgments section of your manuscript. 

 

 

 

NIH tips for writing a research plan 

 

– Ann Sutton 

 

A well-written research plan is vital to the success of an NIH grant proposal. In the NIH’s 

All About Grants podcast episode, “Considerations for a Research Plan,” Dr. Lillian Kuo of 

the National Cancer Institute and Dr. Kentner Singleton of the National Institute of 

Allergy and Infectious Diseases provide the following advice on writing the research plan. 

 

Researchers should first determine the scientific focus of the application so that it can 

be written to appeal to the appropriate NIH review panel (see below). Researchers 

should then write the Specific Aims section so that it can be used to develop the other 

sections. The Specific Aims section is the most widely read part of an application; thus, it 

should tell a compelling story that will sell the science, rather than simply listing a series 

of experiments. The aims should be interrelated but not interdependent and should 

provide the review panel with a clear understanding of how the aims will help the 

researchers address their research question. 

https://authorarranger.nci.nih.gov/#/user-guide
https://grants.nih.gov/podcasts/All_About_Grants/episodes/Research-Plan.htm


One thing researchers should keep in mind is that while review panels address specific 

scientific fields and diseases, the individual members may have different types of 

expertise. The research plan should be written so that all members of the panel can 

understand the problem being presented in the proposal, the approach and 

experiments being described, and how the proposed experiments will address the 

hypothesis or research question. The use of jargon should be minimized. 

 

Three pitfalls to avoid when writing a research plan: 

• Assuming that the reviewers will read the citations and be familiar with the 

researcher’s previous work; if previous studies are important to the proposed 

research, they should be described explicitly. 

• Focusing too heavily on data acquisition in the Specific Aims; researchers should 

clearly address how the data will be analyzed and how they relate to the 

hypothesis and overall significance. 

• Incorrectly assuming that the significance of the research is obvious or that a 

focus on a specific disease or research area alone makes it significant; researchers 

should consider the significance of their science and how it will advance the field. 

 

The NIH offers three tools to help researchers target their applications: 

• NIH RePorter: Locates funded applications in the field and identifies the scientific review 

groups in which they were reviewed, the NIH institutes and centers that fund that field, 

and program officers who can provide guidance before and after review. 

• Center for Scientific Review’s Assisted Referral Tool (ART): Matches an abstract or specific 

aims to a study section or scientific review group. (For more information, see The Write 

Stuff, Autumn 2020 issue, “The Assisted Referral Tool (ART): A resource for selecting the 

best NIH study sections.”) 

• Assignment Request Form: Is used to suggest assignment to a particular funding institute, 

recommend a study section or review group, identify conflicts of interest, or suggest 

expertise using keywords. 

 

The All About Grants podcast is produced by the Office of Extramural Research at the 

NIH. New episodes are added monthly, and the podcast is available on most major 

platforms, such as Apple Podcasts and Spotify. Episodes, transcripts, and more 

information are available on the NIH website. 

 

 

 

 

https://public.csr.nih.gov/ForApplicants/PlanningAndWriting/TargetYourApplication
https://grants.nih.gov/news/virtual-learning/podcasts.htm


Unusual terms used in scientific writing and publishing: Creative Commons 

 

– Bryan Tutt 

 

“Creative Commons” is a term you may come across if you look at a scientific journal’s copyright 

information—especially if it’s an open access journal. Creative Commons is an international 

nonprofit organization whose goal is to facilitate information sharing by providing legal 

information and tools. The most common of these tools is a set of licenses that state the 

conditions under which users can reuse copyrighted content. 

 

Creative Commons offers six licenses denoted by sets of initials, which are summarized below: 

 

• CC BY means that users can copy, redistribute, and adapt the material with only one 

restriction: Users must include attribution (i.e., acknowledge the creator’s copyright). This 

is the least restrictive Creative Commons license. 

• CC BY-SA means that users can copy, redistribute, and adapt the material with two 

restrictions: Users must include attribution, and users who adapt and share the material 

must share the adapted material under the same license. 

• CC BY-NC means that users can copy, redistribute, and adapt the material with two 

restrictions: Users must include attribution, and the material can only be reused or 

adapted for noncommercial purposes. 

• CC BY-NC-SA means that users can copy, redistribute, and adapt the material with three 

restrictions: Users must include attribution, the material can only be reused or adapted 

for noncommercial purposes, and users who adapt and share the material must share 

the adapted material under the same license. 

• CC BY-ND means that users can copy and redistribute the material with two restrictions: 

Users must include attribution, and the material cannot be adapted. 

• CC BY-NC-ND means that users can copy and redistribute the material with three 

restrictions: Users must include attribution, the material can only be reused for 

noncommercial purposes, and the material cannot be adapted. 

In addition to the six licenses, Creative Commons also offers a public dedication status, CC0, 

which means that the creator(s) have given up their copyright and placed their material in 

the public domain for users to redistribute, adapt, and share without restriction. More 

information about Creative Commons is available on their website. 

 

 

 

 

 

https://creativecommons.org/about/cclicenses/
https://creativecommons.org/


Editing services 
 

The scientific editors in the Research Medical Library help MD Anderson faculty and trainees get 

published and get funded. We provide a wide range of editorial, educational, and publishing 

services, free of charge, to the MD Anderson community, including 

• editing grant proposals and research articles; 

• providing one-on-one consultations with authors at any stage of the writing process; 

• teaching workshops and giving lectures on writing research articles and grant proposals; 

• teaching scientific English for non-native speakers; 

• providing writing advice and support, including online writing advice. 

For more information about our editing services and how to use them, please visit Our Editing 

Services, or contact us at RML-Editing@mdanderson.org. 

 

 

Upcoming events for authors 

 

Please see the Research Medical Library website for more information about educational courses, a 

schedule of upcoming events, and recordings of past classes. 

 

 

Writing an Effective K99/R00 Grant Proposal. Over the course of six 1-hour modules, 

scientific editors provide practical advice on writing the Candidate Section, Specific Aims, and 

Research Strategy of a K99/R00 application. 

Registration is required. To streamline and simplify the registration process, the six separate 

modules of this session are set up as a series; registration for one module will register you for all 

six. You can attend any or all modules. The series will be repeated every few months. 

All modules will begin at 1:00 pm. 

Monday, November 1, 2021: Candidate Section, Part 1, Candidate's Background 

Wednesday, November 3, 2021: Candidate Section, Part 2, Career Goals and Objectives 

Monday, November 8, 2021: Candidate Section, Part 3, Plan for Career Development/ 

Training Activities 

Wednesday, November 10, 2021: Specific Aims 

Monday, November 15, 2021: Significance & Innovation 

Wednesday, November 17, 2021: Approach 

REGISTER HERE 

Registration is required through the Research Medical Library. Details: John McCool 

(jhmccool@mdanderson.org). 

https://inside.mdanderson.org/departments/scipub/advice-on-writing-r01-grant-proposals-research-articles-and-other-documents.html
http://inside.mdanderson.org/departments/scipub/our-editing-services.html
http://inside.mdanderson.org/departments/scipub/our-editing-services.html
mailto:RML-Editing@mdanderson.org
https://www3.mdanderson.org/library/education/index.html
https://mdanderson.libcal.com/event/8379753
mailto:jhmccool@mdanderson.org


INTEREST Program. The INTEREST program is a series of mock study sections that leverage the 

expertise of experienced MD Anderson faculty in writing fundable research proposals. It involves 

a rigorous review of extramural grant proposals to improve, critique, and offer experience in the 

grant review process, from the applicant’s and the reviewer’s points of view. For more 

information, contact INTEREST@mdanderson.org. 

Important upcoming dates: 

December 27, 2021 – Deadline to submit your INTEREST Intent Form and a PDF copy of 

your grant abstract to INTEREST@mdanderson.org 

January 3, 2022 – Full application submission deadline 

January 12, 2022 – INTEREST Review Meeting 

 

 

Online Courses in Scientific English for Non-Native Speakers of English. The Research 

Medical Library offers two online courses for non-native speakers of English on the 

Study@MDAnderson platform. Both courses are self-study and self-paced, but students have 

access to an instructor (Dr. Mark Picus) for support and questions. For more information and to 

register, please click here. 

 

 

The Write Stuff is intended for but not restricted to participants in the Writing and Publishing 

Scientific Articles program conducted by the Research Medical Library. The material included in this 

newsletter may be freely distributed, as long as proper credit is given. To subscribe or unsubscribe, 

please email RML-Editing@mdanderson.org or phone 713-792-3305. Copyright 2021 The University 

of Texas MD Anderson Cancer Center. 

mailto:INTEREST@mdanderson.org
https://mdanderson.co1.qualtrics.com/jfe/form/SV_cTMOWVtKESICGK9
mailto:INTEREST@mdanderson.org
http://www3.mdanderson.org/library/education/online.html
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